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1 General

1.1 Bartels AutoEngineer Product Line
The following software configurations are available with Bartels AutoEngineer Version 5.0:

• Bartels AutoEngineer Schematics

• Bartels AutoEngineer Light

• Bartels AutoEngineer Economy

• Bartels AutoEngineer Professional

• Bartels AutoEngineer HighEnd

Bartels AutoEngineer Professional is the standard BAE software configuration. BAE Professional is available
for PCs with Windows, Linux, or DOS operating systems. BAE Schematics, the schematic editor of BAE
Professional is freely available and can be operated in stand-alone mode. Demo software configurations of
BAE Professional (fully-featured except for data output) are available free of charge for test and evaluation
purposes.

Bartels AutoEngineer Light is a shareware price-level BAE configuration for educational purposes and/or
semi-professional users, available for PCs with Windows, Linux or DOS operating systems. BAE Light has
full BAE Professional functionality, however, limited to a maximum PCB layout size of 180mm * 120mm and
a maximum of two signal layers for manual routing and Autorouter.

BAE Economy is a low-price BAE configuration for educational purposes and/or small business users,
available for PCs with Windows, Linux or DOS operating systems. BAE Economy has full BAE Professional
functionality, however, limited to a maximum PCB layout size of 350mm * 200mm and a maximum of four
signal layers to be simultaneously routed by the Autorouter.

Bartels AutoEngineer HighEnd is available for workstations and for PC systems (Windows
95/98/ME/NT/2000, Linux). BAE HighEnd utilizes special operating system characteristics (multi-tasking,
multi-windowing, virtual memory management, etc.) to implement advanced features and functions such as
HighSpeed kernel, in-built messaging system to support advanced communication between different BAE
modules, in-built multi-tasking to support multiple project views, global net highlight, cross-probing, selective
layout short-circuit display, extremely fast Mincon airline calculation, optimized data structures for high
Autorouter performance, advanced Neural Rule System features, rule-driven Neural Autorouter, nettype-
specific routing area definitions, net-specific maximum via count settings, net-specific maximum connection
length settings, etc.

The following software modules are optionally available with the workstation-based BAE systems:

• Bartels AutoEngineer IC Design

• Bartels AutoEngineer Mixed Mode Simulator

Bartels AutoEngineer IC Design (BAEICD) is a complete CAD/CAM system for the physical design of
integrated circuits (gate arrays, standard cells, custom ICs and/or ASICs). BAEICD consists of a series of
system components such as IC Mask Editor, IC Autoplacement, IC Autorouter, IC DRC (Design Rule
Check), and GDS-II and CIF standard interfaces.

Bartels AutoEngineer Mixed Mode Simulator (BAESIM) is a compiler-driven simulator for mixed
analog/digital circuits. BAESIM provides direct access to the net list data generated with BAE Schematics.
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1.2 System Requirements

General System Requirements

A VGA or higher resolution monitor with a screen resolution of at least 800*600 pixels and a mouse or a
corresponding pointing device are required on any BAE platform.

Up to 40 Mbytes hard disk space are required for installing the BAE software.

Operating System

BAE Professional, BAE Economy, BAE Light and BAE Schematics versions are available for Linux (Kernel
2.0.x), Windows 2000, Windows NT 4.0, Windows NT 3.51, Windows ME (Millenium Edition), Windows 98,
Windows 95, Windows 3.x, and MS-DOS.

BAE HighEnd systems are available for Hewlett-Packard 9000/7xx workstations with OSF/Motif and/or X11,
and for PCs with Linux (Kernel 2.0.x), Windows 2000, Windows NT 4.0, Windows NT 3.51, Windows ME
(Millenium Edition), Windows 98, and Windows 95 operating systems.

PC System Requirements

PC systems should be equipped with a Pentium (80586, 80686) or at least a 80486DX processor. Any
compatible processor such as AMD-K6 or AMD-K7 (Athlon) will also do.

A minimum of 8 Mbytes RAM is required for DOS and Windows 3.1 systems (16 Mbytes RAM
recommended). A minimum of 16 Mbytes RAM is required for Windows 95/98/ME/NT/2000 and Linux
systems (32 Mbytes RAM or more for Windows recommended).

The BAE software is usually provided on CD-ROM, i.e., a CD-ROM drive is required to install the software.

A hardlock key is used to protect BAE Economy, BAE Professional and BAE HighEnd Windows and DOS
versions against software piracy. I.e., a printer port (LPT1, LPT2, or LPT3) is required to run these BAE
versions under DOS and/or Windows.

On Linux systems, either a printer port (for the hardlock key) or an Ethernet card is required for checking the
software authorization of BAE Economy, BAE Professional and/or BAE HighEnd.

1.3 Documentation
Both the Bartels AutoEngineer User Manual and the Bartels User Language Programmer's Guide have
been completely revised and are provided in HTML and PDF format (in the baedoc directory of the BAE CD-
ROM).
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1.4 Installing on Windows and DOS Platforms

Preparing for Update Installations

The BAE library and User Language directory contents are replaced when performing update installations.
Thus it is strongly recommended to backup any user-specific data from these directories before installing the
BAE update, and to restore the required data afterwards.

The bsetup.dat file from the BAE programs directory is always re-installed when performing BAE Update
Installations. Thus it is not necessary to run the time-consuming batch for compiling the BAE User Language
programs provided with the BAE software. However, user-specific BAE parameter settings stored with the
existing bsetup.dat file will get lost and must be restored after successfully installing the BAE software using
the bsetup utility program (or the Setup function available from the BAE main menu of the Windows/Motif
versions). Customer-specific User Language programs developed and compiled under the previously
installed BAE version must also be re-compiled after performing the BAE Update Installation.

Running the Windows 95/98/ME/NT/2000 Install Program

Under Windows 95/98/ME/NT/2000, the BAE setup program for installing BAE Demo, BAE Professional,
BAE Economy, BAE Light and BAE Schematics should start automatically after inserting the BAE CD-ROM
to the CD-ROM drive. If this doesn't happen, simply start the setupen.exe program from the CD-ROM using
the Run function from the Windows Start menu. Please follow the instructions of the setup program.

The setup ends with the BAE software configuration. Please select the BAE configuration which is authorised
for your machine (BAE Demo, BAE Professional, BAE Economy, SCM only, etc.; see also table 1).

To install BAE HighEnd, simply run the setup program and then unzip the baew32he.zip file from the
baew32he directory of the BAE-CD-ROM to the BAE programs directory created by the setup program.

Running the MS-DOS/Windows 3.11 Install Program

For installing BAE Demo, BAE Professional, BAE Economy and/or BAE Schematics under Windows 3.11 or
MS-DOS, or BAE HighEnd under Windows 95/98/ME/NT/2000, Windows 3.11, or MS-DOS, the CD-ROM
must be inserted to the CD-ROM drive, and the drive and directory must be set accordingly. E.g., to install
the BAE software from CD-ROM drive D, insert the BAE CD-ROM to CD-ROM drive D, and enter the
following commands to the DOS prompt:

> D: <CR>
> install <CR>

Once the install program has been started, the instructions issued on the screen should be followed
carefully. First you will be asked for the BAE user interface language (e.g., English, German, etc.) and for the
operating system host platform (DOS, Windows NT, Windows 3.x, etc.).

The install program provides different modes for performing either new Installation or Update installations.
The Update install mode is strongly recommended when just updating from earlier BAE Versions; this will
prevent the install program from overwriting special BAE system and setup files ending on .dat, .def, and .fnt
(otherwise, user-defined color tables, aperture tables, fonts, layer definitions, library access path settings,
and menu setups stored with these files might get lost!).

After selecting the install mode, you will be prompted to specify the destination directories for installing the
programs, the libraries, the User Language source files, and the examples and test jobs. You can exclude
certain destination directories by deleting the corresponding path names. Thus more experienced BAE users
can e.g., suppress the installation of the BAE example jobs, or re-install certain parts of the BAE software
later. For security reasons, the install parameter settings will be verified with user query before starting the
installation process. The destination directories will be created automatically on request. The install program
automatically copies the BAE software files to the selected destination directories on the hard disk.

At the end of the install process, the install program asks for the licensed BAE software configuration in order
to install the correct software authorization file (see below). When installing the DOS version, the user will
also be asked to select the graphic device driver to be installed (see below).
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Installing the Software Security Module

The BAE PC software for Windows and DOS (except for BAE Demo, BAE Light and BAE Schematics) is
protected by a hardlock key (dangle) which must be plugged onto one of the parallel ports (LPT1, LPT2, or
LPT3) of your PC. Switch off your computer before mounting the hardlock key shipped with the software, or
otherwise the dangle might be damaged by high voltage! If you have connected a peripheral device such as
a laser printer to the hardlock key, then you must always switch on the peripheral device before switching on
your computer to avoid hardlock key check problems.

The BAE PC software provides the license files according to the available software configurations as shown
in the table below. You will be asked to select the BAE software configuration (and thus the appropriate
license file) when installing the BAE software. Make sure to select the BAE software configuration to be
installed and/or authorized on your computer.

Table 1: BAE Software License Files

 Software
Configuration

License File
Name Note

BAE Demo demo.cfg SCM and Layout
no Hardlock Key, no (CAM) output

BAE Light see note SCM and Layout
no Hardlock Key
customer-specific CFG file is provided on purchase

BAE Economy economy.cfg SCM and Layout

BAE Professional autoeng.cfg SCM and Layout

BAE HighEnd highend.cfg SCM and Layout

BAE Schematics schema.cfg SCM only
no HardlockKey

BAE Layout layout.cfg Layout only
required/provided only for updating from BAE Versions older than
BAE V5.0

The router.cfg license file matching the BAE software configuration authorized on your computer must be
available in the BAE programs directory. I.e., to install the correct license file you can also copy the desired
CFG file to router.cfg within the BAE programs directory instead of selecting the valid BAE configuration
during BAE software installation

BAE Demo software is intended for evaluation purposes only. BAE Demo cannot produce any CAM or User
Language output, and it will mask Layout elements in order to prevent from processing with productive
software configurations afterwards. I.e., the BAE user version are not able to read Demo jobs, however, we
are able to convert these jobs.

Selecting the BAE DOS Graphic Device Driver

With the Windows versions of the BAE software there is no BAE graphic device driver installation required
since BAE Windows software runs under the graphic interface of the corresponding operating system.

The DOS versions of the BAE software are shipped with a series of graphic device drivers. During
installation you will be asked to select an appropriate BAE graphic device driver. Table 2 provides the list of
graphic device drivers supplied with the DOS PC software of the Bartels AutoEngineer. Please select the
graphic device driver matching the video adapter and/or graphic card installed with your computer. It is
recommended to install the standard VGA driver VGA480, if you are not sure about which driver to select
since VGA480 is assumed to run on almost any PC system, and you can always select a different driver
(e.g., with higher resolution) later (see below).
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Table 2: BAE Graphic Device Drivers

 Graphic Driver Type Resolution Chip Set/Manufacturer

CCD480.DEV PGA 640x 480 IGC (Cad Card)

EGA350.DEV EGA 640x 350 Standard

EGA480EW.DEV EEGA 640x 480 EGA Wonder

EGA480GE.DEV EEGA 640x 480 Genoa, ATI

EGA600EW.DEV EEGA 800x 600 EGA Wonder

EGA600GE.DEV EEGA 800x 600 Genoa, ATI

EGA600PA.DEV EEGA 800x 600 Paradise

QPC1024.DEV - 1280x1024 Datapath QPDM

QPDM768.DEV VGA 1024x 768 AMD QPDM

QPDM1024.DEV VGA 1280x1024 AMD QPDM

VGA480.DEV VGA 640x 480 Tseng ET3000 / ET4000

VGA600.DEV VGA 800x 600 Tseng ET3000 / ET4000

VGA768.DEV VGA 1024x 768 Tseng ET3000

TSENG768.DEV VGA 1024x 768 Tseng ET4000

VESA600.DEV VESA 800x 600 various

VESA768.DEV VESA 1024x 768 various

MACH768.DEV - 1024x 768 ATI Mach 64

MACH1024.DEV - 1280x1024 ATI Mach 64

MACH1200.DEV - 1600x1200 ATI Mach 64

MGA600.DEV - 800x 600 Matrox Millenium/Mystique

MGA768.DEV - 1024x 768 Matrox Millenium/Mystique

MGA1024.DEV - 1280x1024 Matrox Millenium/Mystique

MGA1200.DEV - 1600x1200 Matrox Millenium/Mystique

TIGA.DEV TI variable Texas TMS34010 / TMS34020

The graphic driver .dev file matching the video adapter and/or graphic card of your computer must be copied
to the bae.dev file in the BAE programs directory. This is achieved either by selecting the correct driver
during BAE software installation or by manually copying the desired .dev file in the BAE programs directory
to bae.dev.
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Setting up the DOS Environment

It is strongly recommended to add the BAE programs directory path to the PATH environment variable. Load
the autoexec.bat file to your text editor and check whether autoexec.bat contains a PATH statement or not. If
there is already a PATH statement defined in autoexec.bat, then just add the following program path link to
the PATH statement (assume BAE programs directory c:\bae):

;c:\bae

If there is no PATH statement defined in autoexec.bat, then insert the following PATH statement (assume
BAE programs directory c:\bae):

PATH=c:\bae

You can also insert the following command at the end of the autoexec.bat file in order to include the BAE
programs directory path name with the PATH variable:

PATH c:\bae;%path%

The config.sys file must contain the statements

BUFFERS=<b>
FILES=<f>

where the number <b> of buffers should be at least 30, and the number <f> of files should be at least 20.

Note that you must reboot your computer if you made any changes to the config.sys or autoexec.bat.
Otherwise you might not be able to start BAE.

1.5 Installing on Linux and UNIX Platforms

Preparing for Update Installations

The BAE library and User Language directory contents are replaced when performing update installations.
Thus it is strongly recommended to backup any user-specific data from these directories before installing the
BAE update, and to restore the required data afterwards. The same backup and restore process should be
applied to BAE programs directory files with extensions .dat (except for bsetup.dat; see next paragraph),
.def, and .fnt when just updating from earlier BAE versions since these files can contain user-defined color
tables, layer definitions, Gerber aperture tables, and character fonts which will be overwritten during update
installations. The router.cfg file must also be saved and restored when updating from authorized BAE
versions.

The bsetup.dat file from the BAE programs directory will always be re-installed when performing BAE Update
Installations. Thus it is not necessary to run the time-consuming batch for compiling the BAE User Language
programs provided with the BAE software. However, user-specific BAE parameter settings stored with the
existing bsetup.dat file will get lost and must be restored after successfully installing the BAE software using
the bsetup utility program (or the Setup function available from the BAE main menu of the Windows/Motif
versions). Customer-specific User Language programs developed and compiled under the previously
installed BAE version must also be re-compiled after performing the BAE Update Installation.
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Linux Installation

The baelinux directory on the BAE CD-ROM contains the TGZ archive files baelinux.tgz, and baelinus.tgz
(and baelinp.tgz and baelinps.tgz for hardlock key support) with different BAE builds for operating BAE
Demo, BAE Professional, BAE Economy, and BAE Lightt under Linux. Each of these TGZ files contains the
directories bin (programs and setup files), baelib (symbol and part libraries), baeulc (User Language source
files), and baejobs (examples and test jobs). The BAE software is supposed to run on all common Linux
system with Kernel 2.0.x (S.u.S.E. 6.0 or later, RedHat, etc.). The TGZ files baelinhe.tgz and baelinhs.tgz
contain the binaries for BAE HighEnd. An additional file named baeeng.tgz including the English BAE user
interface setup is also provided.

We strongly recommend that you have a look into the readme file from the baelinux directory of the BAE CD-
ROM before installing the BAE Linux software. The readme file contains a list of the provided BAE Linux
archive files and latest information and important instructions for installing the BAE Linux software.

baelinus.tgz must be installed on Linux systems without Motif. baelinus.tgz contains a statically linked BAE
version including all system and Motif libraries (libc6/glibc, lesstif/Motif1.2) required to run BAE on any Linux
Kernel 2.0.x distribution.

It is recommended to use the more efficient dynamically linked BAE version from baelinux.tgz (linked to
libc6/glibc and lesstif/Motif1.2) on Linux systems where Motif is already installed. The statically linked version
from baelinus.tgz can always be used on Linux systems which fail to run the dynamically linked version.

To install the BAE Linux software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under
/cdrom), change to the directory where you want to install the BAE software, and unpack the appropriate
archive file (e.g., baelinux.tgz) using the tar command as in

> tar -xzfv /cdrom/baelinux.tgz <CR>
The -z option is used to filter the TGZ file through the gzip utility. If your tar command does not support the -z
option, simply use gzip and tar as in

> gzip -dv /cdrom/baelinux.tgz <CR>
> tar -xfv /cdrom/baelinux.tar <CR>

To install the dynamically linked BAE HighEnd version, simply extract the baelinhe.tgz file after installing
baelinux.tgz. To install the statically linked BAE HighEnd version, simply install baelinhs.tgz after installing
baelinus.tgz.

A configuration file is provided with productive BAE Linux versions. This configuration file (router.cfg) must
be saved to the BAE program directory (bin, see above) To activate BAE Demo, the demo.cfg configuration
file must be copied to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see
also Table 1).

BAE is pre-configured with a German user interface. The English user interface can be activated by
extracting the baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory.
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UNIX Installation

The BAE HighEnd archive files for UNIX workstation are provided in specific BAE-CD-ROM directories such
as baehp for the HP version. These archive files contain the directories bin (programs and setup files), baelib
(symbol and part libraries), baeulc (User Language source files), and baejobs (examples and test jobs). An
additional file named baeeng.tgz including the English BAE user interface setup is also provided.

The BAE HighEnd archive files for HP workstations are provided in the baehp directory on the BAE CD-
ROM. Please see the readme file in the baehp directory for latest information and instructions on how to
install the BAE HP software.

To install the HP software, simply mount the CD-ROM drive with the BAE-CD-ROM (e.g., under /cdrom),
change to the directory where you intend to install the BAE software, and unpack the baehp.tgz archive
using the tar command as in

> tar -xzfv /cdrom/baehp.tgz <CR>
This installs the BAE HighEnd software with OSF/Motif interface. To activate the BAE HP software for X11,
the baehpx11.tgz file from the baehp directory on the CD-ROM must be installed in the destination directory
after installing baehp.tgz.

A configuration file is provided with productive BAE UNIX versions. This configuration file (router.cfg) must
be saved to the BAE program directory (bin, see above) To activate BAE Demo, the demo.cfg configuration
file must be copied to router.cfg, to activate BAE Schematics, schema.cfg must be copied to router.cfg (see
also Table 1).

BAE is pre-configured with a German user interface. The English user interface can be activated by
extracting the baeeng.tgz archive file from the CD-ROM baelinux directory to the destination directory after
installing the UNIX software.

Setting up the Linux/UNIX Environment

The access rights must be set properly (i.e., execute for the programs, read access to the libraries,
read/write access to the job files, all rights for the system administrator, special rights for the library manager,
etc.). The user must have read access to the BAE program directory files ending on .cfg (for authorization
check) and read/write access to the files with extensions .dat and .fnt. The user must also have write access
in the working directory to enable temporary file creation.

The Linux/UNIX shell environment variable PATH must point to the BAE programs directory to allow for BAE
program call from any other directory. The PATH variable can be set automatically through shell profile
execution (shell script .profile, .login, .bashrc, or .cshrc, according to UNIX derivative, respectively).
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1.6 Parameter Setup and Program Start

BAE System Parameter

The BAE software versions for Windows and Motif provide an interactive program for modifying the BAE
system parameters. Under DOS, however, the bsetup utility must be applied as described herein.

With the BAE software, a setup definitions file template named stdset.def is supplied, which will be installed
to the BAE programs directory. This file contains the following commands for setting the BAE library access
paths:

SCMDEFLIBRARY("<libdir>\stdsym");
LAYDEFLIBRARY("<libdir>\laylib");

where <libdir> is the path name of the BAE library directory. If the library e.g., has been installed to the
directory c:\baelib under DOS or Windows then you should replace <libdir> with this path name in order to
provide correct access to the BAE symbol libraries. If the library e.g., has been installed to the directory
/usr/bae/lib under Linux or Unix, then you should insert the following commands to the setup definitions file
for providing correct access to the supplied BAE symbol libraries:

SCMDEFLIBRARY(/usr/bae/lib/stdsym);
LAYDEFLIBRARY(/usr/bae/lib/laylib);

The setup definitions file can be transferred to the BAE setup file bsetup.dat using the following bsetup
program call (assuming stdset.def to be the name of the setup definitions file, and the BAE programs
directory to be the working directory):

> bsetup stdset <CR>
The bsetup utility program is also used for defining important system parameters such as the documentary
layer definitions and the menu setup. The documentary layer definitions and assignments have major impact
on how manufacturing data is generated. Thus it is strongly recommended to get familiar with the features of
the bsetup utility program before using BAE for the design of real layouts. See Bartels AutoEngineer User
Manual - Chapter 7.2 for details on how to use bsetup.

User Language Programs, Menu Assignments, Key Bindings

The BAE software installs many pre-compiled User Language programs to the bsetup.dat file of the BAE
programs directory. The corresponding source files are are also provided in the User Language directory
(baeulc). See Bartels User Language Programmer's Guide - Chapter 4 for a complete listing and short
descriptions of the BAE User Language programs.

Some of the installed User Language programs define implicit User Language program calls for activating a
modified BAE user interface with many additional functions. You can add even more functions, or you can
modify and/or reset the predefined menu assignments and key bindings. For more details see section 11.5
of these Release Note.

Usually, it is not necessary to (re-)compile the User Language programs delivered with the BAE software,
since the compiled programs will be installed to the bsetup.dat file of the BAE programs directory.
Nevertheless, the User Language directory provides several batch files for automatically compiling all BAE
User Language programs. The CPLSLL (ComPiLe with Static Link Library) batch file is recommended for
compilation. The compile batch can be started in the User Language directory (baeulc) by entering

> cplsll <CR>

to an MS-DOS-Prompt (with the PATH variable pointing to the BAE programs directory!) or with the

> cplsll.bat <CR>
command from a Linux or UNIX shell. The compilation process might last some time according to the power
of your computer.
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BAE Program Start and DDB File Access

Use the following command to start the Bartels AutoEngineer from a DOS prompt or a Linux and/or UNIX
command shell:

> bae <CR>
Design file access can be simplified by starting and/or running BAE from the design and/or project files
directory.

Under Windows, the Bartels AutoEngineer can also be started by selecting the bae.exe file using the Run
function from the Windows Start menu or the Program Manager Files menu. Windows also allows for
application startup by double-clicking the application from within the Windows Explorer and/or the File
Manager, and it is also possible to define an initial working directory for the application to start in. A shortcut
to bae.exe can be placed on the desktop or the Windows Start menu to provide an even more convenient
method of starting up the Bartels AutoEngineer.

When installing the BAE software under Windows 95/98/ME/NT/2000, a BAE program group with shortcuts
for starting the BAE main menu (BAE Main Menu) and the BAE program modules (BAE Setup, Schematic
Editor, Packager, Layout Editor, Autoplacement, Autorouter, CAM Processor, CAM View) and for accessing
the Bartels AutoEngineer User Manual (BAE User Manual) is added to the Windows start menu.

The BAE DDB File option for creating a new BAE DDB file named New BAE DDB File is included with the
New function from the Windows 95/98/ME/NT/2000 Desktop and Windows Explorer context menus to be
activated through the right mouse button. The BAE DDB file context menus provide the BAE Schematic and
BAE Layout options for loading the selected BAE file to the Schematic Editor and/or the Layout Editor.
Double-clicking a BAE DDB file automatically loads the DDB file's standard layout element to the Layout
Editor. The system suggests to create a new layout element if the DDB file does not yet contain a layout
element with default name.

Please consult your operating system documentation for more information on how to configure applications
for startup.

File Access Environment Variables

Environment variable references in file name specifications are automatically substituted. This allows for
definitions such as $BAELIB for the symbol library directory and combined specifications such as
$BAELIB/laylib or $BAELIB/$STDLIB to be used for path and file name specifications in functions such as
Select Library from the Settings/Parameter menu. The environment variables are not evaluated until they are
actually referred for file access. Thus they will be stored with design files to be transferred to different
computers where they can refer to machine-dependent path specifications defined through corresponding
environment variables. Environment variable references are preceded with a dollar sign ($) and must be
either entirely lower-case or entirely upper-case. The ~ character refers to the $HOME variable. Undefined
environment variable references are substituted with empty strings.
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System File Access Environment Variables

The environment variables listed in table 3 are evaluated for advanced configuration of BAE system file
access in network installations.

Table 3: BAE System File Environment Variables

 Environment
Variable

System File
Default Name Contents

BAE_CFG router.cfg BAE Configuration/License File

BAE_BSETUP bsetup.dat BAE System Parameters

BAE_ULCLIB bsetup.dat BAE User Language Programs

BAE_RULELIB brules.dat BAE Rules Database

BAE_LANG language.dat BAE Menu String Tables (language-specific)

BAE_FONTLIB ged.fnt BAE Graphic Character Fonts

BAE_SCMLIB scm.dat SCM Color Tables

BAE_GEDLIB ged.dat PCB Layout Color Tables

BAE_CEDLIB ced.dat IC Layout Color Tables

BAE_CAMLIB cam.dat CAM Gerber Aperture Tables

BAE_DCOLLIB bae.col BAE Display Color Table

BAE_PCOLLIB baep.col BAE Printer Color Table

BAE_WINLIB baewin.dat
baexwin.dat

BAE Windows Position File

Environment variables must specify complete paths to the corresponding system files. This feature can be
used in definitions such as

set BAE_WINLIB=d:\bae\user1.dat

where access to a machine-specific Windows positions file in network installations with central BAE
programs directory is established.

System files without environment variable definition are accessed from the BAE programs directory using the
default system file name.

Windows System Font Selection

The ANSI_FIXED_FONT system font is used on default for displaying status line and dialog text in BAE
Windows versions. Alternatively, SYSTEM_FIXED_FONT can be selected by assigning an arbitrary value to
the BAE_OLDFONT environment variable if ANSI_FIXED_FONT isn't suited for the configured
screen/monitor resolution.
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1.7 User Interface and General Functions
Advanced features such as customized parameter settings and menu configurations and a macro command
interpreter have been implemented through the User Language Interpreter. For more details see section
11.3 of these release notes.

Autosave

The Autosave facility for periodically saving the currently loaded element to a backup file won't save the
element anymore if it has not been changed during the autosave time interval. This prohibits Autosave from
overwriting .bak files in situations where an element is only loaded for viewing/checking purposes.

BAE Window Status Backup

The BAE window full screen mode (together with the normal window position and size) is stored to the
baewin.dat Windows position file when exiting BAE under Windows. The format of the Windows position file
has been changed accordingly. BAE cannot reload old Windows position files. I.e., calling BAE for the first
time after updating the software will create a default size BAE window at default position.

Windows Scroll Views

Scrollbar support has been introduced for BAE Windows text output. This provides unrestricted access to the
contents of lengthy BAE workarea text outputs such as Packager log files/protocols (i.e., no need to view log
file contents through an external editor).

Windows Cursor Key Support

The cursor/arrow keys can now be used under Windows to scroll the BAE display by half of its dimension in
the key-specific direction. The Page Up and Page Down keys scroll the display up or down by its full height.
Scrolling is limited by the boundaries of the currently loaded element. The Home and End keys can be used
to jump immediately to the upper or lower element boundary.

Menu Function Key Bindings

The KEYPROG key programming utility available through key 5 can be used in BAE pulldown menu
interfaces for assigning BAE menu functions to keys by simply chosing a key through (Key Programming)
and Set HotKeys, clicking the (Menu Selection) button in the program menu, and selecting the desired BAE
menu function.

1.8 Symbol and Part Libraries
PDF files displaying all graphic symbols of the officially released BAE libraries are provided in the pdflib
directory of the BAE-CD-ROM.

A series of useful library management User Language programs for library management (library check,
automatic symbol edit, automatic generation of library documentation, etc.) are installed with the BAE
software. See Bartels User Language Programmer's Guide - Chapter 4 for a complete listing of the User
Language programs provided with the BAE software.
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2 Schematic Editor

2.1 General

File Management

The Project Sheet, Project Symbol, Project Label and Project Marker options for creating and accessing
project file elements without having to specify the project file name have been added to the element type
menus of the New, Load, Load with Check, Replace Element and Update Library functions from the File
menu.

The error messages of the Delete Element function displayed invalid element class identifiers for the
elements to be deleted. This problem has been fixed.

Net Name Selection

The dialogs and/or popup menus for selecting net names from label lists support ?prefix input for scrolling
the list display to the specified net name prefix. A net/label name prefix specification such as ?v scrolls to the
first net/label name starting with ?v or, if no such name exists, to the next name thereafter. Net/label list
scrolling positions specified through name prefices are saved for subsequent queries.

Left Mouse Button Operation

A new button (mouse symbol with pressed left mouse button) for calling the MSMODE User Language
program has been added to the toolbar. MSMODE assigns a left mouse button operation mode for BAE
pulldown menu user interfaces. The following operation modes are provided: No Operation (no left mouse
button operation), Context Functions (provide context menu for object clicekd with left mouse button), Delete
(delete object clicked with left mouse button), Move (move object clicked with left mouse button) and Select
(toggle group selection of object clicked with left mouse button). Context Functions is the default assignment.
The new options allow for similar functions to be applied to different element types without having to select
the functions from different menus. The selected mouse operation mode is displayed in the line of the BAE
pulldown menu interface info/status window.

A rectangular frame is defined when moving the mouse by five or more pixels with the left mouse button
pressed. Subsequently, the BAE_RECT User Language program is called when releasing the left mouse
button. BAE_RECT performs a function depending on the currently assigned left mouse button operation
mode. Context Functions operation mode zooms to the mouse-selected frame, Delete exclusively group-
selects the objects in the selected frame and activates the Delete Group function, Move exclusively group-
selects the objects in the selected frame and starts the Move Group function, Select additively group-selects
the objects in the selected frame.

Signal Router Parameter Setting

Controls for setting the Signal Router parameter have been added to the Settings dialog from the Settings
menu. Previously, this parameter could only be set through the submenu of the Move Symbol/Label function
from the Symbols menu.

Spice Netlist Output

The Spice Data Output function for generating Spice netlists has been added to the Import/Export submenu
of the Schematic Editor File menu. Spice Data Output provides options for generating a Spice netlist from the
currently loaded SCM sheet (Whole Sheet) or from the symbols of the currently selected SCM group (Group
Symbols). The output is written to a file with extension .cir.

The Spice Model and Spice Pin Order functions for assigning Spice model types and Spice output pin
sequences for SCM symbols have been added to the Rule Attachment submenu of the Schematic Editor
Settings menu.
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User Language Programs

A series of new SCM functions and features such as

• customized system and display parameters to be activated/loaded from bae.ini file

• online menu function key binding for pulldown menu configurations (KEYPROG)

• mouse operation mode assignment and mouse operation mode display (MSMODE, TOOLBAR,
BAE_LOAD)

• project element load functions (LOADELEM)

• symbol/part clone placement (TBDVSCM)

• symbol/part search by attribute (FINDSPRT)

• symbol/label query functions in symbol/label context menus (SCM_MS)

• symbol query to display attributes (SCMPART)

• connection rule assignments (SCMRULE)

• advanced net highlight functions (SCMCON)

• text size hotkey (SIZE, UIFSETUP)

• group function operation on mouse-selectable regions (BAE_RECT)

• SCM symbol group selection through attributes (SCMGROUP)

• layout part set selection through SCM group symbols (SCMGROUP, GED_MSG)

• Spice model type and pin output sequence assignments to SCM symbols (SCMRULE) and Spice
circuit data output (SPICESIM, SCMIO)

• import/export menu configuration (SCMIO)

• plot element visibility settings (SCMRULE, SCMEPS)

have been implemented with User Language programs.
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2.2 Symbols, Labels

Symbol Clone

A symbol copy function with attribute value transfer has been added to the first two toolbar design view
windows. The copy function can be activated by clicking into the design view window. An automatically
named copy of the symbol/part from the design view window including the symbol/part attribute value
settings is then attached to the mouse/graphic cursor ready for placement on the currently loaded SCM
sheet. Previously, a mouse-click into the design view window activated the function for transferring the
symbol/part attributes from the design view onto placed symbols/parts. This attribute transfer function is now
only available through the Set button s of the design view window. The symbol placement data has been
added to the report which is displayed through the Info button i of the design view window.

Attribute Display

Symbol attribute listings have been added to the symbol report created with the Symbol/Label Query function
of the Other Functions submenu from the Symbols menu.

Pin net name entries have been added to the symbol pin list outputs.

Symbol/Part Name Change

The Change Part Name function from the Symbols menu has been changed to prevent from transferring the
layout part name to the $ attribute of the changed symbol/part. This helps to avoid the confusion previously
being caused by the fact that, since a Packager run is necessary to update the layout part name, old layout
part names were displayed on the schematic prior to a subsequent Packager run.

Attribute Value Input

A dialog box for simultaneously displaying up to 12 symbol attributes is provided with the Assign Value
function for setting symbol/part attribute values under Windows and Motif. For symbols with more than 12
attribute definitions, Next and Previous buttons are provided for forward and/or backward scrolling. The
dialog box contains a line for each attribute. This line consists of a No Value button, an attribute value
input/edit field and the attribute name/label display. The No Value button can be used to clear the attribute
value setting which will be indicated through a !not_set! attribute value display. Clearing the attribute value is
different from specifying an empty string. Empty string attribute values are assigned and transferred as such
to the net list, whilst clearing an attribute value prohibits the system from assigning and/or transferring any
attribute value to the net list.

The DOS and X11 versions of the BAE software provide a menu for selecting attributes and assigning
attribute values.
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Default Symbol Attribute Values

The Attribute Default Value option for assigning default attribute values on symbol level has been added to
the Set Attributes function of the Other Functions submenu from the Symbols menu. These default symbol
attribute values are automatically assigned when placing new symbols.

Under Windows and Motif, a dialog box for simultaneously displaying up to 12 default symbol attributes is
provided. For symbols with more than 12 attribute definitions, Next and/or Previous buttons are provided for
forward and/or backward scrolling.

The attribute value input dialog box contains a line for each attribute definition, consisting of a No Value
button, an attribute value input/edit field and the attribute name/label display. The No Value button can be
used to clear the default attribute value setting which will be indicated through a !not_set! attribute value
display. Clearing the default attribute value is different from specifying an empty string. Empty string attribute
values are assigned and transferred as such to the net list, whilst clearing an attribute value prohibits the
system from assigning and/or transferring any attribute value to the net list.

The DOS and X11 versions of the BAE software provide a loop for selecting attributes and assigning default
attribute values.

The Attribute Default Value option for assigning default symbol attributes to all symbols of a selectable SCM
symbol library has been added to the Symbol Edit Batch function of the Library Utilities submenu from the
File menu.

Symbol Macro Name Display

Symbol level $llname text definitions are substituted with symbol macro names on SCM plan level. The
Packager automatically assigns the $llname attribute value, i.e., the $llname attribute is not available for
interactive and/or explicit attribute value assigments. Symbol name display through $llname text definitions
on SCM symbol label eliminate the need for redefining symbol name texts when creating new SCM symbols
from existing SCM symbols.

Layout Part Macro Name Display

The Backannotation transfers the layout part macro name back onto the $ulname (Used Library Name) SCM
symbol attribute. This attribute can be displayed on SCM plan level through $ulname SCM symbol text
definitions, and it can be queried through Symbol/Label Query function calls. The $ulname attribute is useful
for querying and/or displaying alternate layout part package type assignments.

Edit Symbol Logic

The edit window of the Edit Symbol Logic function from the Symbols can now be resized.

Default Label Symbol

On default, the standard label symbol is used when placing labels for net names without name-matching
label symbol. This default label symbol can be changed through the Select Label Macro parameter setting of
the Settings dialog from the Settings and/or Parameter menu. This feature allows for the assignment of
different label symbols to certain net names and/or net types without having to define a net-specific label
symbol for each of these nets.

Searching Parts by Attribute Value

The Search Attributes option for searching symbols and/or parts by attribute value has been added to the
Find Part function from the View menu. Search Attributes allows for the selection of existing attribute
name/value pairs (with optional attribute value pattern specification support) and lists all symbols with
matching attribute name/value pairs in a symbol selection menu. Selecting a symbol from this menu triggers
a Zoom Window to the selected symbol.



Bartels AutoEngineer Version 5.0

Release Notes Page 21

2.3 Connections

Break Bustap Segments

The Break Segment function from the Connections menu sometimes duplicated bustaps when applied on
bustap segments. This problem has been fixed.

Highlight Nets

The Highlight Nets submenu with the All Nets function for iterating all SCM sheet nets, highlighting one at a
time, and the Named Nets function for highlighting nets with specified and/or menu-selected SCM sheet net
names has been added to the Other Functions menu item from the Connections menu.

2.4 Text, Attributes

Text Attributes

The Set Text Mode function from the Other Functions submenu of the Text menu has been changed to
preserve any text display attributes such as frames and rotation mode.

Center Text

The Center option has been added to the text context menus to be activated with the right mouse button
whilst placing texts with the Add Text, Move Text and Copy Text functions from the Text menu. The Center
option center-aligns the text to the selected text position. The Standard Text option can be used to restore
default text left-alignment.

Text Size Changes

The SIZE User Language program for changing the size of the currently processed text is called when
pressing the s or S hotkey whilst the Add Text, Move Text or Copy Text function from the Text menu or the
Move Name or Move Attribute function from the Symbols menu is active. SIZE provides a list of predefined
text sizes.

2.5 Group Functions

Group Symbol Selection through Attribute Values

The Select Attribute function for selecting symbols through attribute values has been added to the Other
Functions submenu from the Groups menu. Select Attribute allows for the selection of an existing attribute
name/value pair (with optional attribute value pattern specification support) and group-selects all symbols
with matching attribute name/value pairs.

Group Symbol Numbering

The New Names option has been added to the group context menus to be activated whilst placing groups
with the Load Group, Move Group and Copy Group functions from the Edit menu. The New Names option
renames and/or renumbers all currently selected parts according to their symbol part name patterns with part
numbering starting at 1, and collisions with existing part names being avoided. This feature can be used for
creating consecutive part numbering.

Group Move Signal Routing

The Move Group function re-connects any unselected connections to the moved group instead of simply
cutting them off if the Signal Router On option is activated through the Settings dialog from the Settings
menu.
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2.6 Plot Output

HPGL Plot Output

A PG HPGL command has been added to the end of HPGL output files to force a page eject and to prevent
from subsequent plots being plotted onto the same sheet.

Plot Scaling Factor Adjustment

The status messages of the HP Laser Output and Generic Output functions have been extended to indicate
any non-default scaling factor being used for automatic plot to sheet size scaling.

Bitmap Plot Output to Windows Clipboard

The new Output to Clipboard function from the Plot Output menu can be used under Windows for plotting a
bitmap of the currently loaded element into the clipboard ready to be imported (Pasted) to other Windows
applications capable of processing bitmaps. The whole element is plotted on default. The Clipping On option
can be used to restrict the output to a mouse-selectable rectangle. The plot dialog box also allows for bitmap
size specifications and plot rotation mode selection.

Plot Elements Visibility Control

Plot visibility options have been added to the Rule Attachment submenu of the Set Group Rules and Select
Elements functions from the Settings menu. On default, all SCM elements except for comment texts and tag
symbols are plotted. The Plot visibility option can be used to assign the Disable Plotting attribute to other
elements. Plot-disabled elements are displayed on screen using the Variant Attributes color.

Plot visibility modes are saved with design variants, thus allowing for variant-specific plot outputs.

2.7 Hierarchical Circuit Design

Hierarchical Circuit Design Navigation

The Load Block Plan function for loading the hierarchical circuit diagram sheet of a mouse-selectable block
symbol has been added to the Other Functions submenu from the Symbols menu.

Block Diagrams

The Single Sub-Block option for block diagramming has been added to the Plan Blockname parameter
setting. Whilst there are multiple references to a standard Sub-Block allowed, a Single Sub-Block sheet can
only be referenced once. Single sub-blocks are treated like normal SCM sheets by Packager and
Backannotation. I.e., the Packager transfers symbol/part names from single sub-blocks without [Pn] prefices
to the layout, and Backannotation transfers part name changes and pin/gate swaps on single sub-blocks
back to the schematics.
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3 Packager

3.1 Windows Packager Protocol
Under Windows, scrollbars have been added to the text window for Packager messages. This provides
complete access to lengthy Packager protocols without having to view the bae.log log file through an
external text editor.

3.2 SCM Sheet Packager Error Tracking
SCM sheets which can be singled out to have caused Packager errors will be loaded automatically when
switching from the menu-driven Packager versions to the Schematic Editor. In that case, the Schematic
Editor will also trigger a Zoom Window to the first SCM symbol which caused a Packager error.

3.3 Layout Gate Assignments
The new $gp (Gate Pin) attribute can be used to assign SCM symbols to layout gate positions by setting the
$gp value to the desired gate's first pin name from the xlat command of the corrsponding logical library
definition. When using $gp assignments, the $gp value should be set for all gates of the layout part to avoid
gate assignment conflicts. The $gp attribute allows for specific assignments of dual operation amplifier
components, and it can even be used to define connector pin symbols for single pins of multi-pin connectors
where each pin is defined as a gate and the $gp attribute specifies the name of the connector pin. Gate and
pins assigned through the $gp attribute are excluded from layout pin/gate swaps.

3.4 Alternate Part Package Type Assignments
The Packager supports alternate layout part package type assignments through $plname SCM symbol
attibute value settings such as [package1,package2] where a comma-separated list of layout part package
types is specified within the square brackets. In the layout system, the first package type is selected on
default when placing parts. During interactive part placement, the Alternate Part option from the submenus to
be activated through the right mouse button <RMB> can be used to change the part package type of the
currently placed part.
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4 Layout Editor
All autoplacement and automatic copper fill functions from the Autoplacement module have been integrated
to the Layout Editor. The Autoplacement module has therefore become obsolete.

4.1 General

File Management

The Default Layout, Project Default Layout, Project Layout, Project Part, Project Padstack and Project Pad
options for accessing default and project file elements without element name specification dialogs have been
added to the element type menus of the New, Load, Load with Check, Replace Element and Update Library
functions from the File menu. Default Layout accesses the default layout element of a selectable DDB file.
Project Default Layout accesses the default layout element from the current project file. The other options
are used for accessing a selectable element of the choosen class from the project file.

Left Mouse Button Operation

A new button (mouse symbol with pressed left mouse button) for calling the MSMODE User Language
program has been added to the toolbar. MSMODE assigns a left mouse button operation mode for BAE
pulldown menu user interfaces. The following operation modes are provided: No Operation (no left mouse
button operation), Context Functions (provide context menu for object clicekd with left mouse button), Delete
(delete object clicked with left mouse button), Move (move object clicked with left mouse button) and Select
(toggle group selection of object clicked with left mouse button). Context Functions is the default assignment.
The new options allow for similar functions to be applied to different element types without having to select
the functions from different menus. The selected mouse operation mode is displayed in the line of the BAE
pulldown menu interface info/status window.

A rectangular frame is defined when moving the mouse by five or more pixels with the left mouse button
pressed. Subsequently, the BAE_RECT User Language program is called when releasing the left mouse
button. BAE_RECT performs a function depending on the currently assigned left mouse button operation
mode. Context Functions operation mode zooms to the mouse-selected frame, Delete exclusively group-
selects the objects in the selected frame and activates the Delete Group function, Move exclusively group-
selects the objects in the selected frame and starts the Move Group function, Select additively group-selects
the objects in the selected frame.

Part and Net Name Selection

The dialogs and/or popup menus for net list part and net name selections support ?prefix input for scrolling
the list display to the specified name prefix. A name prefix specification such as ?r4 scrolls to the first name
starting with ?r4 or, if no such name exists, to the next name thereafter. Part and net list scrolling positions
specified through name prefices are saved for subsequent name queries.

Pick Preference Layer and Element Selection

A new Pick Mode parameter for selecting the element pick method for multiple elements at the same pick
position has been added to the Settings dialog from the View menu. The Preference Layer default option
picks an element from the currently selected preference layer. The Element Selection option provides an
element selection facility if more than one element is found at the pick position. A loop for highlighting the
selectable elements with status line short description is activated. The highlighted element can be selected
through return key or left mouse button click. The element selection can be aborted through escape key or
right mouse button input. Any other key switches to the next element at the pick position.



Bartels AutoEngineer Version 5.0

Release Notes Page 25

User Language Programs

Part Fixed Mode

All User Language programs for manipulating and/or copying parts, traces and vias have been changed to
preserve any existing part, trace and via fixed modes.

A series of new Layout Editor functions and features such as

• customized system and display parameters to be activated/loaded from bae.ini file

• online menu function key binding for pulldown menu configurations (KEYPROG)

• mouse operation mode assignment and mouse operation mode display (MSMODE, TOOLBAR,
BAE_LOAD)

• project element load functions (LOADELEM)

• placement data query functions in part context menus (GED_MS)

• part search, pin listing output in placement data queries (GEDPART)

• DRC error display and DRC error localization (LERRLIST)

• trace width, text size and group scale hotkeys (SIZE, UIFSETUP)

• hotkeys for rotating layout pick elements (parts, pins, texts, polygons, groups) at arbitrary angles
(GEDPART, LROTATE, RROTATE)

• additional trace display modes for manual routing (GEDTRACE)

• via checking distance assignment to traces (GEDTRACE)

• equidistant parallel traces generation (TRCPARAL, GEDTRACE)

• teardrop generation for selectable via types (TEARDROP)

• polygon line width setting (GEDPOLY)

• polygon outline keepout area generation (GEDPOLY)

• text plot width setting (GEDTEXT)

• drill power layer mask assignments (GEDTEXT)

• copper fill net assignment to isolated vias (GEDVIA)

• group function operation on mouse-selectable regions (BAE_RECT)

• part group selection through attributes (GEDGROUP)

• import/export menu configuration (GEDIO)

• layout part set selection through SCM group symbols (SCMGROUP, GED_MSG)

• part height DRC (GEDPART, GEDPOLY)

have been implemented with User Language programs.
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4.2 Display, Design Rule Check

Grid Settings

Selecting the No Grid display and/or input grid option from the Settings dialog of the View menu prevented
the dialog from being closed. This problem has been fixed.

Query Element

The Query Element function from the View menu has been changed to allow for display changes through
middle mouse button submenus and display function hotkeys.

Height DRC

The Height DRC function has been added to the Other Functions submenu of the Parts menu. The Height
Offset option of the Height DRC function is used to define part-specific DRC height offsets for selectable
parts. The DRC height offset of a part is added to its keepout areas' height DRC specifications when
performing part design rule checks. The vertical regions between the board surface and part-specific height
DRC offsets is free for part placement, thus allowing to place parts underneath each other. The Check
Exclude option of the Height DRC function can be used for selecting an alternate part to be excluded from
the part height design rule check. This feature is useful for placing alternate parts at the same position for
variable and/or exclusive insertion.

The Height DRC function for assigning heights (option Height Specification) and height limits (option Height
Limit) to selectable documentary layer keepout areas has been added to the Other Functions submenu from
the Areas menu. Height specifications are usually assigned to keepout areas on part level whilst keepout
area height limits are usually specified on layout level. Intersecting keepout areas with height specifications
are treated like documentary distance violations.

Height DRC errors are indicated through a rectangle with diagonal lines. Keepout areas with non-zero height
limits are not checked against each other, and the Height Distance Violations entry for displaying the number
of height design rule check violations has been added to the report generated by the Report function from
the Layout Editor Utilities menu.

DRC Error Display Mode

The Settings dialog from the Layout Editor View menu provides the new DRC Error Display parameter for
selecting DRC distance and height rule violation error display colors. The Error Color option displays error
boxes using the error color selected with the Change Colors function, the default of which is white. The
Highlight Layer setting displays error rectangles using the color selected for the layer on which the erroneous
element is placed. Errors on layers which are faded-out through Change Colors are not displayed.

DRC Error List and DRC Error Localization

The DRC Error List function for displaying the DRC distance and height rule violation error list and has been
added to the Utilities menu. The DRC errors are listed in a popup menu, indicating error type, error layer and
error coordinates for each error. A Zoom Window to the error position ist triggered when selecting an error
from the list using the left mouse button <LMB>. The + and - keys can be used to move the zoom window
through the error position list in either direction.
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4.3 Parts, Placement

Part Search

The Find Part function with the Name (Pattern) and Attribute Value options has been added to the Other
Functions submenu from the Parts menu. Name (Pattern) allows for the specification of a part name and/or
part name pattern. Attributes Value allows for the selection of existing attribute name/value pairs (with
optional attribute value pattern specification support). The parts matching the specified part name pattern or
the selected attribute name/value pair(s) are listed in a popup menu. Selecting a part from this menu triggers
a Zoom Window to the selected part, or activates the Add Part if the selected part is not yet placed.

Part Rotation

The LROTATE (Left Rotate) and/or RROTATE (Right Rotate) User Language programs for rotating parts are
activated during part placement when pressing the l or L and/or the r or R keys. These User Language
programs have been changed to support arbitrary rotation angles different from 90 degrees. The rotation
angle step to be applied by LROTATE and RROTATE can be defined through the L/R Rotation Angle option
from the Other Functions submenu of the Parts menu.

Part Set

The Add Part, Place Next Part and Place Parts functions from the Parts menu work on the selected part set.
Initially after loading a layout, all parts are selected, i.e., the system behaves as usual. The functions from
the Part Set submenu can be used to restrict and/or redefine the set of parts selected for placement. The
Place Next Part function issues a All parts have been placed already! message if all parts are already placed
or a All selected parts have been placed! message if all selected parts are already placed, but there are still
unselected parts which have not yet been placed. The part set selection popup window displays placed
selected parts as [ name ], placed unselected parts as ( name ), unplaced selected parts as : name and
unplaced unselected parts as < name >.

Pin/Gate Swap Indicators

Graphical pin/gate swap indicators are now provided with the Pin/Gate Swap function. A circle (0.6mm
diameter, Workspace color) is displayed for every pin/gate swap enabled pin when the Pin/Gate Swap
function is activated. The indicator for the first selected pin turns into a filled square, leaving only swappable
pins marked by circles and character codes for the possible swap operations. The character codes are P for
pin swap, G for gate swap and A (Array) for gate group swap. Selecting black for the Workspace color
deactivates the pin/gate swap indicator display.

Autoplacement

The Autoplacement functions for automatic part placement have been integrated to the Layout Editor. The
new Part Set, Auto Placement and Matrix Placement submenus from the Layout Editor Parts menu provide
the corresponding functions from the Autoplacement module.
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4.4 Traces, Routing

Trace Width Changes

The SIZE User Language program for changing the trace width of the currently processed trace is called
when pressing the s or S key whilst using the Add Trace, Insert Corner, Move/Delete Corner, Move Segment
or Insert Segment function from the Traces menu. SIZE provides a list of predefined trace widths.

Trace Pick

The algorithm for picking trace corners and trace segments has been improved to pick the element with
minimum distance from the pick point instead of a randomly selected element within snapping distance. The
new pick algorithm improves the selection of single trace elements when working in (small) zoom overview
display modes. The trace pick snapping distance has been adjusted to the trace width. I.e., trace elements
(of wide traces or in high zoom display modes) can now easily be picked without having to hit the trace
center line.

Trace Edit Display Mode with DRC

The Fill & DRC display mode has been added to the Edit Display function from the Other Functions submenu
of the Traces menu. With Fill & DRC, traces are displayed as with Fill & Distance, however a design rule
check is activated during interactive routing, changing the distance line display color from trace color to white
upon design rule violations. Elements of the currently processed net are excluded from the design rule
check. The distance line indicates the DRC spacing between traces. I.e., it is possible for a distance line to
cut a pad without a DRC error being displayed if the current trace to copper clearance setting is less than the
trace to trace clearance setting.

Via Check Range for Manual Routing

A new Layout Editor design rule check function for displaying valid via positions during manual routing can
be activated with the Via Check Range function from the Other Functions submenu of the Layout Editor
Traces menu. The via check range is specified in multiples of the currently selected input grid, with valid via
check ranges from 1 to 5. A via check range of 1 only checks the current grid point, a via check range of two
includes all grid points adjacent to the current grid point, thus totalling the via check area to 9 grid points, etc.
Valid via positions are indicated through a small white circle with a diameter equal to the width of the
currently routed trace, but not exceeding 40 percent of the input grid width. The via check is deactivated if
the input grid is disabled or if the No Via Check option from the Via Check Range function is selected.

Via Selection

The Select Single Via function has been added to the Via Functions submenu of the Traces menu. This
allows to Select or Deselect single vias to or from the current group. The function for selecting net-specific
vias has been renamed from Select Vias to Select Net Vias to avoid any possible confusion with the Select
Single Vias function.

Teardrop Generation

The Teardrop Utilities submenu functions can be restricted to generate teardrops on selected padstack types
only. On default, all padstack types are selected for teardrop generation. A design rule check is applied
before generating teardrop areas and/or teardrop traces, and a trace/padstack highlight is activated where
teardrop generation through copper areas or either of the teardrop trace segments is blocked by obstacles.
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4.5 Graphic, Copper Areas

Polygon Pick

The algorithms for picking polygon corners and polygon segments have been improved to pick the element
with minimum distance from the pick point instead of a randomly selected element within snapping distance.
The new pick algorithm improves the selection of single polygon elements when working in (small) zoom
overview display modes.

Polygon Rotation

The LROTATE (Left Rotate) and/or RROTATE (Right Rotate) User Language programs for rotating
polygons are activated during polygon placement when pressing the l or L hotkey and/or the r or R hotkey.
These User Language programs have been changed to support arbitrary rotation angles different from 90
degrees. The rotation angle step to be applied by LROTATE and RROTATE can be defined through the L/R
Rotation Angle option from the Other Functions submenu of the Parts menu.

Polygon Line Width

The Set Polygon Line Width function for assigning individual line widths to selectable documentary lines and
split power plane areas has been added to the Other Functions submenu of the Areas menu. Polygon-
specific line widths are considered by the display and plot functions. The default line width of zero displays
lines with one pixel width and uses the standard line width when plotting polygon lines.

Split power plane line width settings are considered by the connectivity. Any drill hole intersecting or touching
a split power plane line will be isolated from the corresponding power layer.

Reflow-Reflow SMT/SMD Soldering Support

A control for setting the Area Mirror Display parameter has been added to the Settings dialog from the
Settings menu to support the increasingly popular reflow-reflow SMD/SMT soldering process. On default, the
Mirror Display parameter is activated, and polygons with the Visible unmirrored, attribute are only visible
when not mirrored, whilst polygons with the Visible mirrored attribute are only visible when mirrored.
However, with the Mirror Display, parameter deactivated, all polygons declared as Visible unmirrored, are
always visible, and all polygons declared as Visible mirrored, are never visible, independently of any (part)
mirroring. Mirror Display, deactivation allows for SMD libraries designed for conventional SMD soldering to
be re-used for reflow-reflow SMD soldering.
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4.6 Text, Drill

Text Rotation

The LROTATE (Left Rotate) and/or RROTATE (Right Rotate) User Language programs for rotating texts are
activated during text placement when pressing the l or L hotkey and/or the r or R hotkey. These User
Language programs have been changed to support arbitrary rotation angles different from 90 degrees. The
rotation angle step to be applied by LROTATE and RROTATE can be defined through the L/R Rotation
Angle option from the Other Functions submenu of the Parts menu.

Text Size Changes

The SIZE User Language program for changing the size of the currently processed text is called when
pressing the s or S hotkey whilst the Add Text, Move Text or Copy Text function from the Text menu or the
Move Name or Move Attribute function from the Parts menu is active. SIZE provides a list of predefined text
sizes.

Text Plot Width

The Set Text Plot Width option for assigning individual plot widths to selectable texts has been added to the
Other Functions submenu from the Text menu. Text-specific plot widths are considered by the display and
plot functions. The default text plot width of zero displays text with one pixel width and uses the standard line
width when plotting texts.

Element Save Date/Time Display

The $pltstime (element save time), $pltsdatede (element save date, German notation) and $pltsdateus
(element save date, US English notation) texts can be placed to display the time and date the currently
loaded top level element was last saved.

Drill Hole Power Layer Assignment

The Drill Power Layers and Drill Heat Traps functions for assigning drill hole to power layer connection
preferences have been added to the Other Functions submenu from the Text, Drill menu. The Drill Power
Layers function can be used on padstack level for selecting the power layer(s) occupied by mouse-selectable
drill holes. The Drill Heat Traps function can be used on padstack level for assigning power layer specific drill
hole connection modes such as heat trap mode (default) or direct connection mode to mouse-selectable drill
holes. Both functions allow for repeated drill hole selection and drill hole power layer settings assignment in a
dialog box. User interfaces without dialog box support allow for power layer bit mask input.

Drill hole power layer and heat trap rule assignments are important for blind and buried via definitions and
will be considered by the facilities for connectivity generation, power layer display and CAM output.

The rule definitions from the pldrill.rul rule definition file have become redundant and are only provided for
backward compatibility to old project files. Drill hole rule assignments with the Drill Power Layers and Drill
Heat Traps functions automatically detach old power layer rules from the manipulated drill holes.
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4.7 Group Functions

Group Function Messages

Feedback from the Reset Group, Group Polygon, Delete Group, Fix Group and Unfix Group functions from
the Edit menu has been improved by displaying the number of modified elements.

Group Part Selection through Attribute Values

The Attributes option for selecting parts through attribute values has been added to the Select and Deselect
functions from the Other Functions submenu of the Groups menu. Attributes allows for the selection of an
existing attribute name/value pair (with optional attribute value pattern specification support) and group-
selects all parts with matching attribute name/value pairs.

Loading Groups with Traces

The Layout option of the Load without Hierarchy function from the Other Functions submenu of the Edit
menu has been changed to allow for the transfer of traces and vias when working on layout or part level.

Group Rotation

The LROTATE (Left Rotate) and/or RROTATE (Right Rotate) User Language programs for rotating groups
are activated during group placement when pressing the l or L hotkey and/or the r or R hotkey. These User
Language programs have been changed to support arbitrary rotation angles different from 90 degrees. The
rotation angle step to be applied by LROTATE and RROTATE can be defined through the L/R Rotation
Angle option of the Other Functions function from the Parts menu.

Group Scaling

The SIZE User Language program for scaling the currently processed group is called when pressing the s or
S hotkey whilst the Load Group, Move Group or Copy Group function from the Edit menu is active. SIZE
provides a list of predefined group scaling factors.

Group Display Mode

The Moving Picture All option has been added to the Group Display Mode function. Moving Picture All
dynamically displays not only group-selected parts/macros and texts as with Moving Picture On but also the
selected traces, vias and drill holes whilst using the Load Group, Move Group and Copy Group functions.

Group Macro

The Group Macro function has been changed to support alternate part package type assignments for net list
parts which include the specified part macro in their alternate part package type list.
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4.8 Automatic Copper Fill
The copper fill functions from the Autoplacement module have been integrated to the Layout Editor Copper
Fill submenu of the Areas menu and the Add Copper Fill Area function from the Areas menu has been
moved to the Copper Fill submenu. The rest of the Layout Editor Copper Fill submenu is identical to the
Autoplacement Copper Fill menu.

Net/Connectivity Recognition

Passive copper areas with signal net connections (e.g., teardrops created as passive copper) are now
treated like active copper areas of that net and won't be isolated from copper fill areas of that net anymore.

Copper Fill Net Assignments to Isolated Vias

The Set Fill Net function from the Via Functions submenu of the Layout Editor Traces menu can be used to
assign copper fill default nets to group-selected vias. The automatic copper fill functions connect isolated
vias with copper fill net assignments to corresponding net-specific copper fill areas. I.e., this feature can be
used to force the generation of heat-traps in otherwise plain net-specific copper fill areas. Copper fill net
assignments for vias with existing physical trace or copper connections to signal nets are ignored by the
automatic copper fill routines.
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5 Autoplacement
All autoplacement and automatic copper fill functions from the Autoplacement module have been integrated
to the Layout Editor. The Autoplacement module has therefore become obsolete.
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6 Autorouter

6.1 General

File Management

The Default Layout, Project Default Layout, Project Layout, Project Part, options for accessing default and
project file elements without element name specification dialogs have been added to the element type
menus of the Load, function from the File menu. Default Layout accesses the default layout element of a
selectable DDB file. Project Default Layout accesses the default layout element from the current project file.
The other options are used for accessing a selectable element of the choosen class from the project file.

Net Name Selection

The dialogs and/or popup menus for net list net name selections support ?prefix input for scrolling the net list
display to the specified net name prefix. A net name prefix specification such as ?v scrolls to the first net
name starting with ?v or, if no such net name exists, to the next net name thereafter. Net list scrolling
positions specified through name prefices are saved for subsequent net name queries.

User Language Programs

A series of new Neural Autorouter functions and features such as

• customized system and display parameters to be activated/loaded from bae.ini file

• online menu function key binding for pulldown menu configurations (KEYPROG)

• left mouse button context menu (AR_MS)

• mouse operation mode assignment and mouse operation mode display (MSMODE, TOOLBAR,
BAE_LOAD)

• project element load functions (LOADELEM)

• import/export menu configuration (ARIO)

have been implemented with User Language programs.
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6.2 Autorouter Algorithms

Net-specific Airline Display, Net Group Routing

New options for controlling net-specific airline display have been added to the Mincon Function. Nets which
are faded-out from airline display won't be routed. Net-specific airline display settings can be changed
between router passes. This allows for consecutive router passes to route different groups of nets.

Router Pass Status Display

A router pass status line has been added to the router status display window. The router pass status line
displays an identification of the currently active router pass type (L - Load Layout, S - SMD Via Preplacement
Pass, I - Initial Routing Pass, R - Rip-Up Pass, P - Optimizer Pattern Search Pass, O - Optimizer Pass) and
the number n of processed elements in relation to the total number m of elements to be processed by the
current router pass (display n/m). The status display ends with the current pass number c and the total
number p of passes to be processed (display c/p). The values displayed with the router pass status line
cannot be used for accurate total routing time predictions since the required time for completing the routing
of each net and/or connection strongly depends on the current routing complexity.

Router Batch

A Start button has been added to the Batch Setup dialog box for setting up router batches. The Start can be
used for immediately starting the defined router batch without having to leave the Batch Setup dialog through
the OK button and subsequently calling the Batch Start function.

Gridless Mode Diagonal Routing

Full gemoetric calculations are performed on diagonal trace segments to prevent from clearance violations
when routing in gridless mode. Diagonal traces are preferably created with the Optimizer Direction Strategy
parameter set to Diagonal.
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7 CAM Processor

7.1 General

File Management

The Default Layout, Project Default Layout, Project Layout, Project Part, Project Padstack and Project Pad
options for accessing default and project file elements without element name specification dialogs have been
added to the element type menus of the Load function from the File menu. Default Layout accesses the
default layout element of a selectable DDB file. Project Default Layout accesses the default layout element
from the current project file. The other options are used for accessing a selectable element of the choosen
class from the project file.

User Language Programs

A series of new CAM Processor functions and features such as

• customized system and display parameters to be activated/loaded from bae.ini file

• customized Gerber default parameter settings on CAM Processor startup (CAMSETUP)

• online menu function key binding for pulldown menu configurations (KEYPROG)

• left mouse button context menu (CAM_MS)

• mouse operation mode assignment and mouse operation mode display (MSMODE, TOOLBAR,
BAE_LOAD)

• project element load functions (LOADELEM)

• import/export menu configuration (CAMIO)

• IPC-D-356 test data output with drill class plating information support (IPCOUT)

have been implemented with User Language programs.
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7.2 Control Plot

HPGL Plot Output

A PG HPGL command has been added to the end of HPGL output files to force a page eject and to prevent
from subsequent plots being plotted onto the same sheet. The Multiple Layers option must be used for
plotting multiple layers onto the same sheet.

Plot Scaling Factor Adjustment

The status messages of the HP Laser Output and Generic Output functions have been extended to indicate
any non-default scaling factor being used for automatic plot to sheet size scaling.

Bitmap Plot Output to Windows Clipboard

The new Output to Clipboard function from the Control Plot menu can be used under Windows for plotting a
bitmap of the currently loaded element into the clipboard ready to be imported (Pasted) to other Windows
applications capable of processing bitmaps. The whole element is plotted on default. The Clipping On option
can be used to restrict the output to a mouse-selectable rectangle. The plot dialog box also allows for bitmap
size specifications and plot rotation mirror mode selections.

A black on white plot is generated for single output layer selections. With Multiple Layers plot output, the
selected layers are plotted with their currently assigned colors (and mixed color display) on black
background.
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8 CAM View

8.1 General

User Language Programs

A series of new CAM View functions and features such as

• customized system and display parameters to be activated/loaded from bae.ini file

• online menu function key binding for pulldown menu configurations (KEYPROG)

• left mouse button context menu (CV_MS)

• mouse function mode assignment (MSMODE, TOOLBAR)

have been implemented with User Language programs.

8.2 Parameter Setup

Via D Code

The Windows and Motif CAM View Parameter Setup dialogs did not allow to specify Via D Codes larger than
10. This problem has been fixed.
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9 Neural Rule System

9.1 General

Rule Definitions

The brules.dat file installed to the BAE programs directory contains precompiled rule definitions. The source
files for these rule definitions are also provided (User Language directory; file extension .rul), i.e., the rule
definitions can be modified and recompiled with the rulecomp Rule System Compiler.

Rules which only set a single predicate value can be dynamically generated and assigned without having to
define and compile such rules through a .rul file. This simplifies rule system management procedures
significantly. All system-supported rules can be conveniently set through menu-assigned User Language
programs. In-depth knowledge of the Neural Rule System is not necessary for these rule system
applications.

9.2 SCM Rules
BAE Version 5.0 provides a series of new rules for the implementation of special SCM features such as plot
visibility control. See chapter 2 of this documentation for a description of these rules and their applications.

9.3 Layout Rules
BAE Version 5.0 provides a series of new rules for the implementation of special layout features such as pen
width control for polygon lines and texts. See chapter 4 of this documentation for a description of these rules
and their applications.
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10 Utilities

10.1 COPYDDB
The COPYDDB utility program displays usage information when being called without arguments and/or
options. The usage information for the mode and element class options has been extended to provide more
specific help on how to use these options.



Bartels AutoEngineer Version 5.0

Release Notes Page 41

11 Bartels User Language

11.1 General
This section describes general changes to the User Language specification. See Bartels User Language
Programmer's Guide - Chapter 2 for a detailed description of the User Language specification.

Internal User Language Version

The internal version of BAE Version 5.0 User Language has been changed. All User Language programs
compiled under earlier BAE versions won't execute in the BAE Version 5.0 User Language interpreter
environment (error message User Language program version incompatible!). This means that each User
Language program compiled under earlier BAE Versions must be recompiled under BAE Version 5.0 in order
to regain compatibility.

11.2 User Language Compiler
This section describes the news and changes introduced to the BAE User Language Compiler. See Bartels
User Language Programmer's Guide - Chapter 3 for detailed information on how to operate the User
Language Compiler.

Preprocessor Statements

The new preprocessor statement

#pragma ULCALLERSTD

can be used to force the compiled User Language program caller type setting to standard (STD). User
Language programs compiled with this statement can be called in any User Language Interpreter
environment, even if the program code contains system functions or index variable types which are not
compatible to that Interpreter environment. The Incompatible index/function reference(s)! User Language
Compiler error will be suppressed. This allows for the implementation of programs with environment-specific
program code. It is up to the program design to prevent from calling incompatible system functions, or
otherwise the User Language Interpreter will quit the program with a UL(Line): System function not available
in this environment! runtime error message.
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11.3 User Language Interpreter
This section describes the news and changes introduced to the User Language Interpreter. See Bartels
User Language Programmer's Guide - Chapter 3 for detailed information on how to operate the User
Language Interpreter.

Customized Parameter Settings and Menu Configurations

Customized parameter settings, key definitions and menu assignments can be stored to the bae.ini file in the
BAE programs directory. The definitions from this file are loaded once upon BAE startup and can
subsequently be accessed with the varget User Language system function.

The BAE User Language programs are designed to evaluate relevant definitions from bae.ini. Changes to
bae.ini are activated by simply restarting the affected BAE program module, and it is not necessary to
recompile any of the affected User Language programs. I.e., with bae.ini, user-specific parameter settings
can easily be transferred between different BAE versions and/or installations.

The bae.ini file provides specific sections for different BAE program modules. Each BAE program module
only loads relevant sections from bae.ini. The definitions from the std section are relevant for all modules.

bae.ini allows for generic parameter value assignments. The key and fkey commands are used for standard
and function key assignments. The addmenu, addmenuitem, addsmenuitem and addioitem kewords allow for
menu extensions. Please note that menu items can only be appended to main menus and import/export
menus. Menu item insertion is prohibited to preserve online help topic assignment.

A bae.ini file with inline documentation for command syntax explanation is supplied with the BAE software.
The original version of this file activates the parameter settings from the supplied BAE User Language
programs. I.e., these (default) settings are also activated if the bae.ini is not available in the BAE programs
directory.

Macro Command Interpreter

A macro command interpreter has been built into the Run User Script, function, the ulsystem User
Language system function, the bae.ini key and menu function assignment facilities and the KEYPROG
online key programming utility to allow for the specification of interaction/command sequences (macros)
instead of User Language program names. Intercation codes must be separated with the : character. The p
prefix is used to identify User Language program names (this prefix should be omitted if the User Language
program name is the first item in the macro). The # prefix emulates a bae_callmenu User Language function
call for activating a BAE menu function. Text input is specified through single-quoted strings. t awaits user
text input. s activates a menu selection, which, if followed by l, m or r and a (zero-based) menu index triggers
a menu function similar to a bae_storemenuiact function call. m awaits a mouse click, which, if followed by
l, m or r, triggers a mouse click with input coordinates retrieved from the mouse position at the beginning of
the interaction sequence if the mouse key in the macro isn't followed by coordinate specifications.

With macro specifications, it is possible to assign submenu functions such as Symbol/Label Query (macro
scmpart:s5:m:t:mr) to keys. It is also possible to define macros for frequently required interaction sequences
such as the Schematic Editor macro #500:m:mr:sl3:'4':'0':mr:sl0 for creating a 4mm horizontal graphic line
from the current mouse position to the right (SCM symbol graphic pin connection).
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11.4 Index Variable Types
This section lists the new and changed User Language index variable type. See Bartels User Language
Programmer's Guide - Appendix B for a detailed description of all index variable types.

New Index Variable Types

The following new User Language index variable types have been implemented for BAE V5.0:

IP Index Variable Type Short Description

LAY L_DRCERROR Layout DRC Error Marker
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11.5 System Functions
This section lists the new and changed User Language system functions. See Bartels User Language
Programmer's Guide - Appendix C for a detailed description of all system functions.

New System Functions

The following new User Language system functions have been implemented for BAE V5.0:

IP System Function Short Description

STD bae_getmenuitem BAE menu item query

cap_figboxtest Check SCM element rectangle cross

cap_findblockname Find SCM block circuit sheet with given block name

cap_getscrefpidx Get currently scanned SCM reference element

cap_ruleconatt Attach rule(s) to SCM connection segment

CAP

cap_rulecondet Detach rules from SCM connection segment

scm_gethighlnet Get SCM net highlight modeSCM

scm_highlnet Set SCM net highlight mode

ged_drcpath GED trace test placement design rule check

ged_drcpoly GED polygon test placement design rule check

ged_drcvia GED via test placement design rule check

ged_getdrcstatus Get GED DRC completion status

ged_getdrcmarkmode Get GED DRC error display mode

ged_setdrcmarkmode Set GED DRC error display mode

ged_getpickmode Get GED element pick mode

ged_setpickmode Set GED element pick mode

ged_getgroupdata GED group placement data query

GED

ged_getinputdata GED input data query

ICD icd_lastfigelem Get last modified IC Design figure list element
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Changed System Functions

The maximum menu entry count for menus activated through bae_askmenu has been increased from 15 to
30. The bae_defselmenu function has been adapted accordingly.

Passing an empty string to the second parameter of the bae_loadelem system function now loads the
default layout element if the layout element class is specified with the third function parameter.

The size of multiline edit windows activated through the bae_readedittext system function can now be
changed.

To avoid redundant screen redraws at the redefinition of color tables, the bae_setcolor system function
does not perform a screen redraw anymore. I.e., it has become the responsibility of the bae_setcolor caller
to trigger screen redraws as required at the end of a color table definition sequence. The ARDISP,
DRILLOUT, FONTEDIT, GEDDISP, GENLMAC and SPOPCOL User Language programs have been
changed accordingly.

The bae_swconfig function has been extended to allow for BAE Schematics software configuration checks.

The cap_blocktopflag system function has been changed to return a specific code for sheet defined as
single sub-blocks for hierarchical block circuit diagrams.

The maximum Gerber aperture table index to be addressed through the cam_getgerberapt and
cam_setgerberapt system functions has been increased from 200 to 900 to allow for the management of
Gerber tables with up to 900 different apertures.
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11.6 BAE User Language Programs
BAE installs more than 180 pre-compiled User Language programs to the bsetup.dat file of the BAE
programs directory. Additionally, the User Language source files (more than 3 Mbytes; more than 110,000
lines) are installed to a special directory (baeulc). See Bartels User Language Programmer's Guide -
Chapter 4 for a complete listing and short descriptions of the BAE User Language programs.

Include Files

The User Language include files already delivered with the previous BAE Version have been completely
revised and extended by a series of new definitions and functions.

New User Language Programs

The following new User Language programs are provided with BAE Version 5.0:

IP Program Name Short Description

BAE_RECT BAE Mouse Rectangle Frame Action

MSMODE Set Mouse Context Operation Mode

STD

SIZE Resize Pick Element

SCM SPICESIM Spice Circuit Data Output

GED LERRLIST Layout DRC Error List Display

AR AR_MS Autorouter Mouse Action

CAM CAM_MS CAM Processor Mouse Action

CV CV_MS CAM View Mouse Action

Changed User Language Programs

The User Language programs already delivered with the previous BAE Version have been completely
revised and extended by many new features and functions. A series of significant improvements and
enhancements have already been mentioned in the previous sections of these Release Notes. A series of
User Language programs have been equipment with parameter query dialog boxes. New features and
functions have been made available through existing User Language program menus wherever appropriate.
Almost all User Language programs have been enhanced to load customized system and display
parameters from the bae.ini file.
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